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LESSON 1 -  
CREATING/REVISING PIVOTTABLES  

In this lesson, you will learn how to: 

• Create a PivotTable report  

• Add PivotTable report fields  

• Select a page field item  

• Refresh a PivotTable report  

• Change the summary function  

• Add new fields to a PivotTable report  

• Move PivotTable report fields  

• Hide/Unhide PivotTable report items  

• Delete PivotTable report fields  

• Create a page field report  

• Format a PivotTable report  

• Create a PivotChart report  

• Publish PivotTable reports to the Web  

• Add fields to a PivotTable - browser  

• Use a PivotTable list  
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CREATING A PIVOTTABLE REPORT 

 Discussion 
A PivotTable report can summarize large amounts of data quickly. PivotTable reports 
allow you to manipulate row and column headings around the central data so that you 
can view the data in different ways. 
 
PivotTable reports are organized into fields and items. Fields are the rows or columns 
of data; items are the specific entries within a field. For example, if you want to 
summarize data by month, each month becomes an item in the Month field. Data 
fields contain the numbers you want to summarize or analyze, such as sales or 
volume. 
 
You can filter PivotTable report items using a page field. A page field displays only 
the data for the selected page field item. For example, if you have a Quarter page 
field, you can view the summarized data for all quarters or only for a single quarter. 
 
Excel has a PivotTable and PivotChart Wizard to step you through the process of 
creating a PivotTable report. First, you select the source of the original data, such as a 
list or database in an Excel worksheet or in an external database. Next, you select the 
range of data you want to use. The final step of the PivotTable and PivotChart Wizard 
is to select the worksheet location for the PivotTable report. 
 
The field layout of the PivotTable report is where you specify the row, column, and 
page fields, as well as the data you want to summarize. This step can be performed in 
a window in the PivotTable and PivotChart Wizard or directly in the worksheet. If the 
source data is an Excel workbook, it is easier to lay out the PivotTable report directly 
in the worksheet. If the source data is an external database or an extremely large 
database, it may be easier to use the Layout window in the PivotTable and PivotChart 
Wizard. 
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A blank PivotTable report 

 
  

 
You can also use a PivotTable report to analyze data created in 
an external data source, such as Access. Worksheet data can 
also be imported into Access. 

  
 

 Procedures 

1. Open a worksheet containing a database. 

2. Select any cell in the database. 

3. Select the Data menu.  

4. Select the PivotTable and PivotChart Report command. 

5. Select the data source you want to analyze. 

6. Select the kind of report you want to create. 

7. Select Next >. 

8. If necessary, select the database range and then select Next >. 

9. Select where you want the PivotTable report to appear. 

10. Select Finish. 
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ADDING PIVOTTABLE REPORT FIELDS 

 Discussion 
The fields in a PivotTable report can be laid out directly in the worksheet. The four 
areas of the PivotTable are row fields, column fields, page fields, and data items. Each 
area of the PivotTable displays placeholder text (such as Drop Column Fields Here). 
 
When a PivotTable report is active, the available database fields appear in the 
PivotTable Field List window. If necessary, you can open the PivotTable Field List 
window by clicking the Show/Hide Field List button on the PivotTable toolbar. 
 
You lay out the PivotTable report by dragging fields directly into the desired area of 
the PivotTable report. For example, if you want to arrange the data by displaying the 
months at the beginning of each row, you can drag the Month field to the Drop Row 
Fields Here area. Likewise, to display the product names at the top of each column, 
you can drag the Product field to the Drop Column Fields Here area. 
 
The Drop Data Items Here area contains items to be calculated. Consequently, fields 
dragged to this area are usually, but not limited to, numerical fields. For example, for 
a Month by Product report, you can drag the Sales field to the Drop Data Items 
Here area; your PivotTable report will then display the total sales per product by 
month. 
 
Page fields are often used to filter information in large databases. They can break a 
large report down into smaller, more manageable reports. If the database includes a 
Region field, this field can be used to summarize the sales in a specific region. 
 
Each area of a PivotTable report has its own identifying symbol that appears when 
you add a new field to the report. As the field is dragged across the different areas of 
the PivotTable report, its identifying symbol changes accordingly. 
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A completed PivotTable report 

 
  

 
The PivotTable report area must be selected for the PivotTable 
Field List window to open. 

  

 
You can dock the PivotTable Field List window to the left or 
right side of the Excel window. 

  
 

 Procedures 

1. Display the PivotTable toolbar. 

2. Select any cell in the PivotTable report to activate the report and 
open the PivotTable Field List window. 

3. Drag the desired field from the PivotTable Field List window to the 
Drop Row Fields Here area. 

4. Drag the desired field from the PivotTable Field List window to the 
Drop Column Fields Here area. 

5. Drag the desired field from the PivotTable Field List window to the 
Drop Page Fields Here area. 

6. Drag the desired field from the PivotTable Field List window to the 
Drop Data Items Here area. 
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SELECTING A PAGE FIELD ITEM 

 Discussion 
Page fields allow you to filter the PivotTable report by displaying only the data for a 
specific field item; you can drag any field to the page field area. The page field list 
then displays all the items in the page field. 
 
When you select an item from the page field list, only the data relating to that single 
item appears in the PivotTable report. For example, if items in the Region page field 
include Northeast, Northwest, Southeast, etc., and you select the Northeast item, 
only the data for the Northeast region appears in the PivotTable report. 

 
Using a page field item to filter data 

 

 Procedures 

1. Click the page field list. 

2. Select the desired item. 

3. Select OK. 
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REFRESHING A PIVOTTABLE REPORT 

 Discussion 
If the source data changes, a PivotTable report does not automatically update. If you 
change the existing data, delete records or fields, or add records or fields to the 
original database range, you need to refresh the PivotTable report. 
 
If you add records below the last row or add fields to the right of the last column in a 
database, you will have to open the PivotTable and PivotChart Wizard to expand the 
data source range to include the new rows and/or columns. 
 

  

 
You can open the PivotTable and PivotChart Wizard by 
clicking in an existing PivotTable report, and selecting the 
PivotTable menu on the PivotTable toolbar and the Wizard 
command. 

  
 

 Procedures 

1. Select any cell in a PivotTable report to activate it. 

2. Click the Refresh Data button  on the PivotTable toolbar. 

 

CHANGING THE SUMMARY FUNCTION 

 Discussion 
By default, an Excel PivotTable report sums fields that contain numeric data and 
counts fields that contain text. The PivotTable report can provide summary 
information using other mathematical calculations as well. A PivotTable report can 
average data, provide the minimum and maximum values, or yield the standard 
deviation or variance. A PivotTable report can also contain multiple summaries for the 
same field. 
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The PivotTable Field dialog box 

 
  

 
When a PivotTable report contains multiple data fields, you 
can change the summary function for a field by selecting any 
cell in the row of the data field you want to change. 

  
 

 Procedures 

1. Display the PivotTable toolbar. 

2. Select any cell in the PivotTable report data area. 

3. Click the Field Settings button  on the PivotTable toolbar. 

4. Select the desired summary function from the Summarize by list 
box. 

5. Select OK. 

 

ADDING NEW FIELDS TO A PIVOTTABLE REPORT 

 Discussion 
PivotTable reports can display multiple fields in the row, column, page, or data areas. 
Multiple fields can add more detail to your PivotTable report. If a PivotTable report 
contains the Month row field and the Product column field, you can add a Purchaser 
row field to be able to display monthly sales by customer as well. 
 
New fields can be added to a PivotTable report by dragging them from the PivotTable 
Field List window to the desired PivotTable report area. The new field can be 
positioned before or after any existing fields. The position of the field determines how 
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the data will be summarized. You can display the purchasers for each month by 
placing the Month field before the Purchaser field, or you can reverse the field order 
to display the purchaser first, followed by the month. 
 
As you drag new fields into a PivotTable report, guidelines indicate the position of the 
field in relation to existing fields. When positioning a field in the row area, the 
guideline is a thick, gray vertical bar, which appears to the left or right of an existing 
row field. When positioning a field in the column area, the guideline is a horizontal 
bar, which appears above or below existing field items. When the guideline appears to 
the left of a field in the row area, or above the field items in the column area, the new 
field will be placed before the existing field. 

 
Adding a field to a PivotTable report 

 
  

 
You can drag a field to a different position in the PivotTable 
report at any time; this feature is helpful if you accidentally 
position a field in the wrong area.  

  
 

 Procedures 

1. Select any cell in the PivotTable report to activate it and open the 
PivotTable Field List window. 

2. Drag the field you want to add to the PivotTable report from the 
PivotTable Field List window to the desired PivotTable report area 
and position. 
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MOVING PIVOTTABLE REPORT FIELDS 

 Discussion 
You can change the layout of the PivotTable report by moving fields from one area to 
another. By moving the fields, you can experiment with the best way to display your 
data. 
 
As you move fields in the PivotTable report, thick, gray bars indicate the placement of 
the field. Vertical bars represent row area placement and horizontal bars represent 
column and page area placement. 
 

  

 
You can also move a field from one area to another by 
dragging the desired field from the PivotTable Field List 
window to the desired area; the field is removed from its 
previous area and appears only in the destination area. 

  
 

 Procedures 

1. Drag any field to move it from one area of the PivotTable report to 
another. 

 

HIDING/UNHIDING PIVOTTABLE REPORT ITEMS 

 Discussion 
You do not have to display all the field items in a PivotTable report. You can hide 
selected items, such as some of the products in a Product field. You can hide 
everything except the data you need to view. 
 
You can also unhide items at any time. To unhide items, you follow the same 
procedure as you do when hiding items; you simply select the items you want to view 
in the field item list or select (Show All) to view all the field items. 
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 Procedures 

1. Select the field item list containing the items you want to hide. 

2. Deselect the items you want to hide. 

3. Select OK. 

 

DELETING PIVOTTABLE REPORT FIELDS 

 Discussion 
If you no longer want to view a field in your PivotTable report, you can remove it 
from the report. A field can be removed by dragging it away from the PivotTable 
report into the worksheet. 
 

 Procedures 

1. Drag the field you want to remove away from the PivotTable report. 

 

CREATING A PAGE FIELD REPORT 

 Discussion 
You can use the Show Pages command on the PivotTable menu to create a separate 
PivotTable report for each item in a page field. The Show Pages feature creates a 
copy of the PivotTable report in a new worksheet for each page field item. For 
example, if you have a Region page field, and you select the Show Pages feature, a 
separate worksheet is created for each region in the Region page field list. 
 
Page field reports are inserted before the original PivotTable report worksheet. 
 

  

 
You cannot undo the Show Pages feature. To remove a page 
field report, you must delete the worksheet on which it 
appears. 

  

 
You can double-click any data field item to display its details 
on a separate worksheet. 
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 Procedures 

1. Display the PivotTable toolbar. 

2. Select any cell in the PivotTable report to activate it. 

3. Select the PivotTable menu on the PivotTable toolbar. 

4. Select the Show Pages command. 

5. Select the page field for which you want to create page field reports.  

6. Select OK. 

 

FORMATTING A PIVOTTABLE REPORT 

 Discussion 
You can use the AutoFormat feature to give a PivotTable report a more professional 
look. AutoFormat provides many formats, which include cell shading, font style and 
color, and borders. 
 
There are two main format styles for PivotTables: reports and tables. A table style 
retains the original row/column (cross-tabulated) arrangement. A report style 
rearranges the data into an indented layout, arranging the fields in a hierarchical 
column arrangement. A report AutoFormat makes it easier to read complex 
PivotTable reports. 
 
If you are not satisfied with AutoFormat, you can undo it. AutoFormat does not 
format page fields. 
 
You can manually change the format of text and numbers using normal Excel 
formatting commands. 
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Formatting a PivotTable report 

 
  

 
If you create page field reports from a formatted PivotTable 
report, each page field report will be formatted the same as the 
PivotTable report. 

  

 
You can rename fields in a PivotTable report by double-
clicking the label you want to rename and typing the desired 
name into the PivotTable Field dialog box. 

  

 
Selecting None from the AutoFormat list removes all 
formatting from a PivotTable report. 

  
 

 Procedures 

1. Display the PivotTable toolbar. 

2. Select any cell in the PivotTable report to activate it. 

3. Click the Format Report button  on the PivotTable toolbar. 

4. Select the desired format. 

5. Select OK. 
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CREATING A PIVOTCHART REPORT 

 Discussion 
A PivotChart report allows you to manipulate large amounts of data in a graphical 
environment. 
 
PivotChart reports can be created from a database or an Excel list, or from an existing 
PivotTable report. Both methods yield the same result, a chart with a layout you can 
change to view different levels of detail and data. When you create a PivotChart 
report, Excel automatically creates an accompanying PivotTable report on a separate 
worksheet. 
 
Creating a PivotChart report is similar to creating a PivotTable report. The chart 
layout is created by dragging fields from the PivotTable Field List window to the 
desired area of the PivotChart report. The chart layout, however, is slightly different 
than the report layout. 

 
A PivotChart report 

 
  

 
You can use the Chart Wizard button on the PivotTable 
toolbar to create a PivotChart report from an existing 
PivotTable. 

  

 
You may need to move the PivotTable Field List window, the 
PivotTable toolbar, and the Chart toolbar to view the various 
areas of a PivotChart report. 
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 Procedures 

1. Open a worksheet containing a database.  

2. Select any cell in the database. 

3. Select the Data menu.  

4. Select the PivotTable and PivotChart Report command. 

5. Select the data source you want to analyze. 

6. Select the kind of report you want to create. 

7. Select Next >. 

8. If necessary, select the database range and then select Next >. 

9. Select Yes or No to base your PivotChart report on an existing 
PivotTable report, if applicable. 

10. Select the PivotTable report on which you want to base your 
PivotChart report, if applicable. 

11. Select Next >. 

12. Select where you want to place the PivotTable report. 

13. Select Finish. 

14. Drag the desired fields from the PivotTable Field List window to the 
Drop Category Fields Here area of the PivotChart report. 

15 Drag the desired fields from the PivotTable Field List window to the 
Drop Data Items Here area. 

16. Drag the desired fields from the PivotTable Field List window to the 
Drop Series Fields Here area. 

17. Drag the desired fields from the PivotTable Field List window to the 
Drop Page Fields Here area. 

 

PUBLISHING PIVOTTABLE REPORTS TO THE WEB 

 Discussion 
Excel 2002 allows you to publish PivotTable reports as web pages. If you want others 
to be able to make changes, you can add interactivity to the published file. With 
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interactivity, anyone can change the layout of the PivotTable report while viewing it 
in a web browser. 
 
When a PivotTable report is published with interactivity, it is known as a PivotTable 
list. Not all web browser viewers are able to use a PivotTable list. The user must be 
using Internet Explorer 4.01 or greater as a web browser and must also have Microsoft 
Office Web Components installed. Users of a different browser can view the 
PivotTable report, but cannot use its interactive features. 

 
Publishing a PivotTable report to the Web 

 
  

 
Although you can include symbols such as number signs (#) 
or periods (.) in field names in a PivotTable report, you should 
not do so if you intend to publish the report as an interactive 
PivotTable list. Field names in a PivotTable list, however, can 
include spaces. 

  

 
You can also publish interactive PivotChart reports to the 
Web. If you include interactivity, the PivotChart and 
PivotTable reports are published on the same web page. 
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 Procedures 

1. Open a workbook containing a PivotTable report you want to publish 
to the Web. 

2. Select the worksheet containing the PivotTable report you want to 
publish. 

3. Select the File menu. 

4. Select the Save as Web Page command. 

5. Type the desired file name in the File name box. 

6. Select the Save in list. 

7. Select the drive where you want to save the HTML file. 

8. Open the folder where you want to save the HTML file. 

9. Select Publish. 

10. Under Item to publish, select PivotTable. 

11. Under Viewing options, select the Add interactivity with option. 

12. Select the Open published web page in browser option. 

13. Select Publish. 

 

ADDING FIELDS TO A PIVOTTABLE - BROWSER 

 Discussion 
PivotTable lists are interactive PivotTable reports that can be manipulated in a web 
browser. Users can change the layout and fields of a PivotTable list in their web 
browser. In order to use PivotTable lists, the web browser must be Internet Explorer 
version 4.01 or greater, and the Microsoft Office Web Components must be installed. 
 
A PivotTable list can be changed using the toolbar buttons that appear at the top of the 
list. You can add fields to the row, column, filter, data, or detail areas using the Field 
List button on the toolbar above the PivotTable list. The row, column, and data areas 
are identical to those in a PivotTable report. The page area in a PivotTable report in a 
worksheet, however, is known as the filter area in a PivotTable list. The detail area is 
a collapsed field in the data area. 
 
You can drag fields to rearrange or remove them from the PivotTable list. 
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An interactive PivotTable list 

 
  

 
Users viewing the PivotTable list in a different browser will 
be able to view the PivotTable list, but not use its interactive 
features. 

  

 
You will not be able to view the details for a PivotTable list if 
it is based upon an OLAP (On-Line Analytical Processing) 
database; only summarized data is available for OLAP 
databases. OLAP databases are used to create queries and 
reports for large databases. Non-OLAP data, such as Access 
databases and Excel lists, display all available data. 

  
 

 Procedures 

1. Open an HTML file containing an interactive PivotTable list in 
Internet Explorer 4.01 or greater. 

2. Click the Field List button  on the toolbar above the 
PivotTable list. 

3. Select the field you want to add from the PivotTable Field List 
window. 
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4. Select the list to the right of Add to. 

5. Select the area to which you want to add the field. 

6. Select Add to. 

 

USING A PIVOTTABLE LIST 

 Discussion 
PivotTable lists can be changed using objects available in the Internet Explorer 
window. Although PivotTable reports in worksheets display only the fields you select, 
PivotTable lists in a web browser contain all the underlying details from the source 
data. You can show or hide individual field or item details as desired by clicking the 
plus and minus buttons adjacent to each field and item. Drop-down lists for row, 
column, and page fields can be used to customize the PivotTable list by showing or 
hiding the data for specific items within a field. 
 
The toolbar above the PivotTable list provides buttons for copying and sorting fields, 
enabling and disabling filters, calculating fields, and displaying and refreshing data. 
 
The Show Top/Bottom Items button allows you to filter a field to display a specific 
number or a specified percent of top or bottom items. For example, you can display 
the five top salespeople in the Salesman field. Once a filter has been applied, you can 
use the AutoFilter button to enable or disable the filter. 
 
You can change the type of calculated data displayed in the filter area. You can use 
the AutoCalc button to add calculated fields and the Calculated Totals and Fields 
button to create custom calculations. In addition, the Show As button can be used to 
change the data display in the filter area to percents. 
 
The Export to Excel button exports the PivotTable list to an Excel worksheet. 
 
The Command and Options button is used to format fields as well as show and hide 
elements of the PivotTable list. The Commands and Options dialog box is context-
sensitive; the pages and options available depend upon what is selected in the 
PivotTable list. 
 

  

 
The Show Details and Hide Details buttons on the toolbar 
above the PivotTable list perform the same functions as 
selecting the plus or minus buttons adjacent to each field. If an 
item is selected, only that item will collapse or expand; if no 
items are selected, all items in the PivotTable list will collapse 
or expand. 
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When you point to a data item, details about that item appear 
in a ScreenTip. 

  

 
You can hide the interactive PivotTable list toolbar by right-
clicking the toolbar and deselecting the Toolbar command or 
by deselecting the Toolbar option on the Behavior page in 
the Command and Options dialog box.  

  
 

 Procedures 

1. Open a PivotTable list in Explorer 4.01 or greater. 

2. Click the field name of the row or column with the subtotal you want 
to hide or display. 

3. Click the Subtotal button  on the toolbar above the PivotTable 
list. 

4. Click the field name of a row or column you want to expand. 

5. Click the Expand button  on the toolbar above the PivotTable 
list. 

6. Click the plus button adjacent to any item you want to expand. 

7. Click the minus button adjacent to any item you want to collapse. 

8. Select the arrow to the right of the field you want to customize. 

9. Select or deselect the field items you want to hide or display, 
respectively. 

10. Select OK. 
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